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Tutorial - I.Basics

Part 2 -  Rules of Audacity  - Part 2

If you'd like to get straight playing an imported file or recording something, you can skip this
section and come back later.

Whenever you work with Audacity, there are some rules you should remember:

1. One clip per track

A clip is simply a piece of audio material. Imported, recorded, split or duplicated from another
track, one track can only carry one piece of audio at a time. You can extend it by pasting
material or inserting silence in to it, or cut a piece away, but it will always be one continuous
piece of audio.

2. Audacity always records to a new track

This new track is opened at the bottom. You'll have to zoom out and then resize the track view
of the bottom most track to see what is recorded. You can actually use the window sliders at
the bottom and right to do this after starting to record, but this way no performance will be lost
to the windowing system.
I suggest hitting CTRL+F to get an overview of the entire project as well. This only affects the
horizontal zoom by the way(left-right zoom). There is no way to zoom out vertically without
using the mouse yet.

3. Edit/Duplicate will not create a new audio file

This may not seem a big deal, but it is if you're editing a large live recording.

What Audacity does is reference the original audio material until you actually perform some
kind of edit on it, such as cutting a piece away, or using any effect on it. One thing to
remember is the UNDO function. You can undo/redo stuff as many times as you like, and yes,
even after you have saved your project.

You may ask what happens if you do, for example, cut away a piece or mark off a 30 minute
piece and split it to a new track. It only writes changed data to disk. Since Audacity works with
chunk of audio data of around one megabyte in size, this happens quite fast. Rest assured that
the only big waiting period might be the importing of large audio files.

To further explain how Audacity works, flip to the next page ...

Next Part - Setup, Audio Import and Playback

Back to the main page



10/17/2007 09:46 PMTutorial - Basics - Part 3 - Setup, Audio Import and Playback

Page 1 of 3http://audacity.sourceforge.net/manual-1.2/tutorial_basics_3.html

Back to the main page Back to the Tutorial Page  
Digital Audio  Rules of Audacity  Setup, Audio Import and Playback  Recording with Audacity

Tutorial - I.Basics

Part 3 -  Setup, Audio Import and Playback  - Part 3

1. Create a new project

This is very important!

Audacity writes all the changed and recorded audio to a directory called Projectname_data, which is
located right where you saved the project file itself.

Thus, select  and choose a location and filename for your project.

Please note that when you startup Audacity fresh, only the " Save As..." menu option is available.

To save your project later on, you can also use the keyboard shortcut : CTRL+S

2. Check the Preferences

Again, this is very important!

Press CTRL+P  or go to ... ...then check if the right output is selected : 

...set the sample rate of your choice... ...and here's a crucial screen :
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(44.1 kHz is the default)

The File Formats settings need discussing at this point.

When importing uncompressed audio, there are two ways to do it. "Make a copy of the original before
editing" means, that Audacity actually copies the entire audio file that you imported in to its project data
directory and in the process sets up the little overview graphics, whose descriptions get stored in the
project data directory too.

The second way is to use the original imported audio. You may think we're actually editing this file, but
no we aren't. In fact, Audacity will now read the imported file once and simply create the graphics
overviews for them in the data directory, and subsequently write to disk all the audio data that you
change. The original file is only used for playback. All audio that remains unchanged will be played from
the original file.

The advantage of choosing to make a copy of the original is that you avoid trouble, should anything in
the original file change.

For example, should you accidentally delete the original file, you're lost.

You have to make up your mind before you start a project. Choose to make a copy of all imported files,
and you'll use more space on your hard disk(s), but it will be easier to back up the project too, because
all files that have anything to do with your project will be in the project data directory.

The Uncompressed Export Format can be set to WAV or AIFF for now. Please check the fileformats page
for further information on export formats.

We'll ignore the Spectrogram settings for now. The Directories setting can be ignored as well for now,
because all it sets is the directory to use for recordings, undo data and other stuff, if you haven't yet
saved your project. Since we already saved our project, this setting is of no importance to us, though
you may want to set it properly later on. Initially this is set to a folder called "audacity_temp_1.2" in the
system temporary directory.

3. Import an audio file

There are three ways to do this:
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1. Simply drag and drop the audio file in to the Audacity window. (If you're using Mac OS 9 or X, drag
the audio file to the Audacity icon instead...)

2. Select Import Audio ... in the Project menu.

3. Use the keyboard shortcut : CTRL+I

Audacity can import WAV, AIFF, AU, IRCAM, MP3 and OGG files. Please refer to the fileformats page for
further reference on these audio formats.

4. Playback

The imported file should now be displayed in an audio track. The track will look a little like this, depending
on what you imported :

Trackpanel and Waveform Overview of the imported Track

If you're not sure where to find audio material, simply rip some off a CD, or in Windows, check the Media
folder in the directory of your Windows installation.

Now click on the green Play button  at the top and you should hear the file you have just

imported.

Next part - Recording with Audacity

Back to the main page
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II.Editing for Beginners

Part 2 -  Cut, Copy and Paste  - Part 2

From here on you may encounter funny letter combinations in boxes  like this.

These are keyboard shortcuts to the functions presented to you in the text. These can be either
single keys (e.g. SPACE ) or combinations that need to be held down at the same

time(e.g. CTRL+C ). You can usually create your own. Check out the this page for more details.

The most basic editing step is cut and paste. It's what people did with tape and it's easy with
data in computers, so take a look at these basic operations, referred to as Cut, Copy and
Paste. The next page will handle Silence, Duplicate and Split. You may also want to check
out the reference section, so you'll know where to find all the tools and how to resize tracks for
example.

It is assumed that you have a project open and that at least one track of audio material is
present.

Let's take a look at this example of an Audacity window:

The View

The Audacity Window
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As you can see by the graphics above, the time shift tool  is selected. It is used to move
the entire audio clip around inside its track.

The cursor (little blinking line across a track and the timeline) will remain at its position, so
effectively you'll be sliding your audio material underneath the cursor.

Let's say we want to cut out that bit in the middle then. First we've got to select it.

Making a selection

To select the part you wish to cut, copy or paste to, use the selection tool . If it's not
activated, do so now by clicking on it in the toolbar.

Now press and hold the left mouse button while you drag the mouse to mark an area.

This area is darker than the surrounding area of the clip. Note, that even though you can mark
an area larger than or extending beyond the actual audio clip in the track, the operations will
only work on the actual clip. Playback however will work outside the clip.

Press the space bar to listen to the audio in the marked area. 
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To extend or contract your selection, hold down the SHIFT  button and click on the area you
wish your selection to extend or contract to.

If you click at a spot that is on the right hand side from the middle of the current selection,
you will set the right hand boundary of your new selection.

Cutting the selection

Cut the selection by selecting "Cut" from the Edit menu ...  or press CTRL+X .

Before the cut After the cut

      

To undo this operation, select Undo in the Edit menu or press CTRL+Z

Copy will copy the selection to the clipboard.

You can then paste that data back in to any track by clicking where you want this audio to be
inserted and select Paste in the Edit menu,

or press CTRL+V .

Thus pasting is the opposite of cutting. You can also copy material, make another selection with
the mouse and then paste. This will replace the selected material with the contents of the
clipboard, no matter how short or long either of them are.

during all operations of this kind, the bottom row of the screen will display two things, namely
the start time and the end time of your selection. The display to the left if that called "Project
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rate:" and its value, defaulting to 44100, can be changed by clicking on that number and
selecting another from the drop-down menu. This sets the sample rate of everything you
produce in audacity.

All files, no matter which will be played at the project rate, and exported at that rate. Should
the sample rate of a track be different from the Project Rate, these tracks will be resampled
to the Project Rate as the project is played back or exported.

Audacity will not change the sample rate of any imported audio. If you want to change the rate
of an imported track for any reason this can be done using the Rate option on the track pop-
down menu.

proceed to Part 3 - Silence, Duplicate and Split .

Back to the main page
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II.Editing for Beginners

Part 3 -  Silence, Duplicate and Split  - Part 3

Silencing unwanted sources

This operation flattens the selection. It essentially is a cut operation without deleting the
selection completely. After all, if you cut a second away, nothing remains. Using the Silence
operation will still leave you with a flatlined area.

When silencing parts between vocal lines, please keep in mind that a sudden drop in
background ambiance can have an bad effect, so at the very least fade the area around the
silenced part, to minimize that effect. Rules to start with are, fade in quickly and fade out
slowly.

Alternately, use the envelope tool to lower the volume in that area. That way, you can
comfortably change it later.

Keyboard Shortcut : CTRL+L

Duplicate

The selected area gets copied, a new track is created and the copied material is pasted in to
that new track at the same point in the timeline.

To illustrate, here's the image from the menu reference:

The benefits of a duplicate are many. One of these is experimentation with effects.

Some of you may say "I can do that with the original track too". But you can't change the
volume of your effect and original audio separately. If you put some Reverb on to your audio,
you can only lower that processed audio in volume later on. If you duplicate the audio first and
use the reverb on that(with 100% reverb and 0% original signal), you can freely change the
volume for both the original and reverb signal.

Also, you can do weird and wonderful things to your duplicates to create special effects. You'll
have two pieces of the same audio to work with. Silence parts, reverb another, phase a third,
filter another and see how that sounds. It is so easy to duplicate a piece of audio and do weird
things to it, so try it. Combining sounds produces magic.

A special note on performance :
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The new piece of audio isn't actually copied on the hard disk. Audacity will still play from the
original audio file(s) until you change a piece of it.

Keyboard Shortcut : CTRL+D

Split

This performs the same as Duplicate, but it also silences the selected material, after copying it
to a new track. Again, here's the illustration from the menu reference:

There are plenty of good uses for this function, but I'm not going to tell you about them here.
You'll have to go to the next part for the meat of this tutorial.

Keyboard Shortcut : CTRL+Y

go to
Part 4 - Splitting and Submixes .

Back to the main page
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II.Editing for Beginners

Part 4 -  Splitting and Submixes  - Part 4

Moving bits of an Audio track

In all projects you'll be pushing your audio around at some point. Otherwise, what are you
doing here ?

There are techniques, easily achievable with Audacity, to cover almost any kind shifting you'd
want to do. In our example, we have a small sentence of speech, where the speaker made a
pause after the first word. We'd like to eliminate that pause.

The part after the pause is selected

Select

Then the split function is used to pop the selected audio to a new track

Split
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The Time Shift Tool  is selected and the audio on the lower track is moved left.

Move Audio and select for fading

Now, it's a good idea to listen to the two
tracks individually for breathing sounds for
example.

Use the solo button of the tracks for this. Then
listen them both in the mix. Again, you can
use the solo buttons for this.

If you have a lot of other tracks playing at the
same time, press the solo buttons on both
tracks. There should be no over lapping or cut-
off breathing sounds.

When you're satisfied, fade out the last two
thirds of the overlapping upper part of the
track, and fade in the first two thirds of the
lower overlapping audio.

Two thirds, and not the whole overlapping
audio, are chosen to keep the level of audio
constant. If the whole overlapping parts were
faded, you would get a level drop of 3dB in the
middle of those fades.

You can check this out by taking a piece of
music, duplicating it, and then fading the
tracks, one fading out, the second fading in. In
the middle of those fades, the level of the mix
will drop audibly. Do a fade over last two thirds
for the fade out and first two thirds for the
fade in, and you probably won't notice any
change in level.

Two thirds is a guideline, but not the law, so
you may have to experiment a little.

Mixing it back together again

!!!Remember!!!

The final mix is done with the Export as WAV function in the File Menu. Here we'll be looking at
creating submixes with the Quick Mix function.

You've done a lot of edits and now have dozens of little tracks with little bits and pieces here
and there. It might look like this:
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Bits and Pieces spread all over the screen
First four tracks selected for quick mixing

We can use the Quick Mix function in the Project menu to bring down the number of tracks.
However, you don't need to mix everything in to one new track.

Select the tracks you want to mix together by SHIFT+click  'ing on the track panels. In the
graphics above, the first four tracks are selected.

Then select Quick Mix. In this example I have quick mixed everything down to two tracks :

Bits and Pieces, quick mixed down to two tracks

And thus, two submixes were created. Remember though, that we did this for convenience of
not having to organize a large number or tracks.

If you still want to shift bits around later on, you should make sure that the parts being mixed
to a track do not overlap, so you can split it away and edit it again later.

Back to the main page Back to the Tutorial Page  
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V.Selecting and aligning 
Part 1 -  Selecting   - Part 1

Basic rules

Selecting can be done with the keyboard, the mouse or by combining the keyboard and mouse.

You need to have the Selection Tool  activated for making a selection.

The exception is selecting the entire track by clicking on the track panel. The align functions all
still work the same way no matter which tool is activated. However, making selections and
placing the cursor still requires the Selection Tool.

The selection modifier key is SHIFT .

In a word processor or text editor, the SHIFT key is the modifier to turn any character that you
enter via the keyboard in to an UPPERCASE character. In Audacity and most audio editing
applications, holding down the SHIFT key means that any cursor movement or placement will
result in a selection.

What follows are ways of making selections.

How do I ...

select audio on one track ?

Place the cursor on the waveform of a track,
hold down the mouse button, drag the mouse
and release the mouse button. 
You can select audio with the keyboard as well,
but may need to place the cursor with the
mouse first. You need to hold down the
SHIFT  key and use the left/right  cursor
keys to expand the selection. Combine the
former with the CTRL  key (STRG on the
German keyboard) to shrink the selection.

expand/shrink my selection ?

Hold the SHIFT  key, then click and hold the
mouse button. 

select all the audio of a track ?

Click on the track panel. The resulting selection
will be confined to the contents of that track.

select all the audio of two or more
tracks ?

It cannot be done precisely right now, if one
track isn't within the range of the other. It
actually doesn't have to be, because of the
group functions in the Align menu, but more of
that later. 
If the start and end of one track is within the
start and end of the other, simply select the
longer track, then SHIFT + click  the second
track panel. 
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mouse button. 
If you clicked to the left of the center of the
current selection, you will now be able to move
the left selection boundary with your mouse.
The same goes for the right hand side of the
selection center. Release the mouse button
when you are satisfied. 
You can use the cursor keys as well. It works
the same way as described in the previous
item.

select from the cursor to the start of
the track ?

Use the Start to Cursor function in the Edit
menu.

select from the cursor to the end of
the track ?

Use the Cursor to End function in the Edit
menu.

select from the cursor to the start of
the project ?

Hold the SHIFT  key and click on the Skip to
Start button.

select from the cursor to the end of
the project ?

Hold the SHIFT  key and click on the Skip to
End button.

If the start and end of one track is not within
the start and end of the other, select the one
track, then expand the selection by SHIFT +

clicking  in to the second track until the
selection encompasses all the desired material.

select all the audio of the project ?

Use the Select All function in the Edit menu, or
hit CTRL+A .

Back to the main page Back to the Tutorial Page  
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Edit Toolbar
All these tools perform the exact same function, as those accessible through the Edit menu,

View menu and keyboard shortcuts.

                

  Cut

Removes the selected audio data and places
it on the clipboard. Only one "thing" can be
on the clipboard at a time, but it may contain
multiple tracks.

  Copy

Copies the selected audio data to the
clipboard without removing it from the
project.

  Paste

Inserts whatever is on the clipboard at the
position of the selection cursor in the project,
replacing whatever audio data is currently
selected, if any.

  Trim

Deletes everything but the selection.

  Silence

Erases the audio data currently selected,
replacing it with silence instead of removing it
completely.

  Undo

This will undo the last editing operation you
performed to your project. Audacity currently
supports full unlimited undo - meaning you
can undo every editing operation back to the
last time the document was closed and re-
opened.

  Redo

This will redo any editing operations that
were just undone. After you perform a new
editing operation, including simply resizing a
track, you can no longer redo the operations
that were undone.

  Zoom In

  Zoom Out

  Zoom to Selection

  Zoom to entire Project

Back to the main page Back to the Reference page  
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Main Toolbar

 Selection Tool

This is the main tool you use to select audio.
Click in a track to position the cursor, or click
and drag to select a range of audio. If you
drag from one track to another, you can
select multiple tracks. Extend a selection by
shift-clicking a new point in the track.

Playback will always begin at the position of
the selection cursor. If a range of audio is
selected, only the selected range will play.

 Envelope Tool

The envelope tool gives you detailed control
over how tracks fade in and out, right in the
main track window. When the envelope tool is
selected, the amplitude envelope of each
track is highlighted in a green line, with
control points at the beginning and end of
each track. To change a control point, click it
and drag it to a new position. To add a new
point, click anywhere in the track where there
is not already a control point. To remove a
point, click on it and drag it outside of the
track until it disappears, then release.

 Time Shift Tool

This tool allows you to change the relative
positioning of tracks relative to one another in
time. To use this tool, simply click in a track
and drag it to the left or right. To align two
tracks together or reset their time shift back
to zero, use the Align Tracks Together or
Align with Zero commands.

 Zoom Tool

 Cursor to Start

Places the cursor at the start of the project.
SHIFT + click  expands the selection to the
start of the project.

 Play Button

Press the play button to listen to the audio in
your project. You can also hit the spacebar to
start or stop playback. Playback begins at the
current cursor position. If a region of audio is
selected, only the selected region will play. To
quickly play the entire project, execute Select
All before playing. If there are multiple tracks
going to the same channel in your project,
they will be mixed automatically for playback.

 Record Button

Press the record button to record a new track
from your computer's sound input device. Use
the Preferences to configure the recording
options. In particular, there is an option to
record stereo or mono, and there is an option
to play the other tracks while recording.

Recording always happens at the project's
sample rate.

 Pause Button

Will pause during playback, or during
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 Zoom Tool

This tool allows you to zoom in or out of a
specific part of the audio. To zoom in, click
anywhere in the audio. To zoom out, right-
click or shift-click. If you have a middle
button, you can middle-click to do the same
thing as Zoom Normal.

In addition, you can zoom into a region by
clicking and dragging the mouse to highlight
the region you want to see, then releasing
the mouse button.

 Draw Tool

Enables the user to draw in to the actual
waveforms. This is especially useful to
eliminate small pops and clicks from material.
ALT + click  smoothes a area of audio 

CTRL + click & hold  edits only one sample,
no matter whether you move the mouse left
or right.

recording. Press again to unpause.

 Stop Button

Press the stop button or hit the spacebar to
stop playback immediately.

 Cursor to End

Places the cursor at the end of the project.
SHIFT + click  expands the selection to the
end of the project.

Back to the main page Back to the Reference page  
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Mixer Toolbar

Output Input Input Selector

These sliders control the mixer settings of the soundcard in your system.

The sliders will jump to zero (left most position) if the drivers do not expose these functions.
This is the case with some digital I/O cards from RME and possibly others as well. Generally
most cards that have a custom mixer application rather than the standard OS volume control
won't work with this function of audacity. On these cards you will not be able to control the
anything with these sliders, and you will need to set up the recording levels and the recording
source using the card's mixer program.

Output Slider

This is the left hand slider that lets you
control the output level of your soundcard. It
actually controls the output setting of the
soundcard driver.

Should your output sound distorted, this is
not the first place to look. You might get
lucky though, so give it a quick slide. Usually
however, the distortion comes from the mix
of your project clipping. You actually need
to reduce the level of your tracks. It is
suggested you reduce every track by the
same amount.

Input Slider

This is the right hand slider that lets you control
the level of the input selected in the Input
Selector. It actually controls the recording level
setting of the soundcard driver.

What you record is also determined in the mixer
settings on your soundcard. There you can
switch certain sources on and off, such as the
Line Input, the Microphone Input or the CD
Audio.

After selecting the corresponding input source
with the Input Selector, you can control the level
of the recording with this slider. Use the VU
Meters on the Meter Toolbar to get the correct
recording level.

Should your input sound distorted, you should
lower this slider until no distortion can be heard,
and the VU Meters do not hit the end of their
travel.

Input Selector

Pick the input source you wish to
record from. All these items are
exposed by the soundcard driver, so

Here is an example of an ESS 1969
soundcard with the Line In input
selected.
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the this of options will vary with
different soundcards.

selected.

Back to the main page Back to the Reference page  
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File Edit View Project Generate Effect Analyze

Analyze Menu
Note: plugins that accept input but produce no output will be placed in the Analyze menu. By default, this

menu is often empty.

Beat Finder

no documentation available yet

Sample Analyze Nyquist Plugin ...

Will place labels that mark the beginning and
end of a selection.

Back to the main page Back to the Reference page  
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File Edit View Project Generate Effect Analyze

Edit Menu
Undo

This will undo the last editing operation you
performed to your project. Audacity currently
supports full unlimited undo - meaning you can
undo every editing operation back to when you
opened the window.

Redo

This will redo any editing operations that were
just undone. After you perform a new editing
operation, you can no longer redo the
operations that were undone.

Cut

Removes the selected audio data and places it
on the clipboard. Only one "thing" can be on
the clipboard at a time, but it may contain
multiple tracks.

Copy

Copies the selected audio data to the clipboard
without removing it from the project.

Paste

Inserts whatever is on the clipboard at the
position of the selection cursor in the project,
replacing whatever audio data is currently
selected, if any.

Trim

Deletes everything but the selection.

 

Delete

Removes the audio data that is currently
selected without copying it to the clipboard.

Silence

Erases the audio data currently selected,
replacing it with silence instead of removing it
completely.

Split

Moves the selected region into its own track or
tracks, replacing the affected portion of the
original track with silence. See the figure
below:

Duplicate

Makes a copy of all or part of a track or set of
tracks into new tracks. See the figure below:
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Select... > All

Selects all of the audio in all of the tracks.

Select... > Start to Cursor

Selects all the audio from the start of the
timeline to the current cursor.

Select... > Cursor to End

Selects all the audio from the cursor to the
end of project, which is as far as audio exists
in the project.

Find Zero Crossings

Moves the cursor or the edges of the selection
to the nearest point where the audio waveform
passes though zero. Use this to help achieve
click-free cuts in audio, as the two ends of the
cut will exactly line up.

Selection Save

Saves the current selection and position. This
function only saves the selection boundaries,
but not the actual audio data.

Selection Restore

Restores the selection to the project. You need
to have an existing selection for this to work.

Move Cursor...

These commands provide quick and accurate
ways to manoeuvre the cursor around the
project to the start and end of tracks and
selections.

Snap-To...

Turns snapping of the cursor to a grid of time
values on or off. When off, your cursor can be
positioned on any sample in the audio file.
When on, it is restricted to certain points in
time, determined by the time format in use.
This is useful if your project must follow an
external timecode exactly.

Back to the main page Back to the Reference page  
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Effects Menu
Audacity includes many built-in effects and also lets you use a wide range of plug-in effects.
You can download many free plugins for Audacity at our Website. Loads of information is also
available at http://www.kvr-vst.com.

To apply an effect, simply select part or all of the tracks you want to modify, and select the
effect from the menu. Titles which end in an ellipsis (...) will bring up a dialog asking you for
more parameters.

There are four classes of effects and they are all applied the same way. These are 

Internal Effects , VST Effect Plugins (Windows/Mac only), Nyquist Effects  and LADSPA Effects

Internal Effects

Amplify...

This effect increases or decreases the volume
of a track or set of tracks. When you open the
dialog, Audacity automatically calculates the
maximum amount you could amplify the
selected audio without causing clipping (from
being too loud).

Bass Boost...

This is a safe, smooth filter which can amplify
the lower frequencies while leaving most of the
other frequencies alone. It is most effective if
you don't try to boost too much; 12 dB is
usually just right.

Echo...

A simple delay line.

This effect repeats the audio you have selected
again and again, softer each time. There is a
fixed time delay between each repeat.

First select the audio you want to apply the
effect to. You may want to first add silence to
the end of your track(s) so that the echo has
plenty of time to die out. When you select

Invert

This effect flips the audio samples upside-
down. This normally does not affect the sound
of the audio at all. It is occasionally useful, for
example when the left and right channels of a
song both contain equal amounts of vocals, but
unequal amounts of background instruments.
By inverting one of the channels and not the
other, the vocals will cancel each other out,
leaving just the instrumentals. Obviously this
only works if the exact same vocal signal is
present in both of the channels to begin with.

Noise Removal...

This effect is ideal for removing constant
background noise such as fans, tape noise, or
hums. It will not work very well for removing
talking or music in the background.

Removing noise is a two-step process. In the
first step, you select a portion of your sound
which contains all noise and no signal, in other
words, select the part that's silent except for
the noise. Then choose Noise Removal... from
the Effect menu and click Get Profile. Audacity
learns from this selection what the noise
sounds like, so it knows what to filter out later.
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"Echo..." from the Effect menu, Audacity will
ask you for two numbers.

The first number is the amount of delay
between the echos, in seconds. The second
value is the decay factor, which is a number
between 0 and 1. A decay factor of 0 means
no echo, and a decay factor of 1 means that
each echo is just as loud as the original. A
value of 0.5 means that its amplitude is cut in
half each time, so it dies out slowly. Smaller
values will make it die out even more quickly.

The Echo effect is very simple and is not
intended to be used in place of a Reverb effect,
which simulates the sound of a room, concert
hall, stage, or other natural environment.
Audacity for MacOS and Windows comes with
Gverb, a free LASPA Reverb plug-in.

Note that if you set the decay value to 1.0,
you can use Echo to create loops that repeat
as long as you want any never change volume.

Fade In

Applies a linear fade-in to the selected audio.
For a logarithmic fade, use the envelope tool.

Fade Out

Applies a linear fade-out to the selected audio.
For a logarithmic fade, use the envelope tool.

FFT Filter...

This is the most general type of filter. You
define a curve that shows how much louder or
quieter each frequency in the signal should be
made. 
If you're careful, you can use it to highlight
exactly the frequencies you want. However,
doing an FFT filter is more likely to result in
artifacts, especially if the filter you draw is not
smooth.

Then, select all of the audio where you want
the noise removed from and choose Noise
Removal... again. This time, click the
"Remove Noise" button. It may take a few
seconds or longer depending on how much you
selected.

If too much or not enough noise was removed,
you can Undo (from the Edit menu) and try
Noise Removal... again with a different noise
removal level. You don't have to get a new
noise profile again if you think the first one
was fine.

Removing noise usually results in some
distortion. This is normal and there's virtually
nothing you can do about it. When there's only
a little bit of noise, and the signal (i.e. the
voice or the music or whatever) is much louder
than the noise, this effect works well and
there's very little audible distortion. But when
the noise is very loud, when the noise is
variable, or when the signal is not much louder
than the noise, then the result is often too
distorted.

Future versions of Audacity may include
improved versions of this effect.

Phaser...

The name "Phaser" comes from "Phase
Shifter", because it works by combining phase-
shifted signals with the original signal. The
movement of the phase-shifted signals is
controlled using a Low Frequency Oscillator
(LFO).

Reverse

This effect reverses the selected audio
temporally; after the effect the end of the
audio will be heard first and the beginning last.
Some people reverse small portions of audio to
make inappropriate language unintelligible,
while others believe you can hear subliminal
messages if you listen to speech backwards.
You can also create interesting sound effects
by recording natural events and reversing the
audio.

Wahwah...
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Just like that guitar sound so popular in the
1970's.

This effect uses a moving bandpass filter to
create its sound. A low frequency oscillator
(LFO) is used to control the movement of the
filter throughout the frequency spectrum.

The WahWah effect automatically adjusts the
phase of the left and right channels when
given a stereo recording, so that the effect
seems to travel across the speakers.

 

VST Plug-ins

To use a VST plug-in effect, put the effect in the directory (folder) called "Plug-Ins", which
should be in the same directory where Audacity resides. If there is no directory, create one. You
will also need to download and unzip the VST Enabler to the same directory. The next time you
launch Audacity, any plug-ins you added will appear in the Effect menu.

Freeverb2...

Audacity for Mac OS and Windows comes with
a VST plug-in called Freeverb, which is in
version 2 (hence "Freeverb2"). This effect
implements a versatile and high-quality reverb
effect.

Getting a good reverb sound depends a lot on
the source audio and can take a lot of
experimentation. One good strategy is to select
a small portion of audio (a few seconds) and
try to add reverb. Listen to it, then Undo and
try it again with different settings. Keep doing
this until you've found the settings you like the
sound of best, and then Undo one last time,
Select All, then apply the effect to your entire
recording.

There are a lot of parameters to Freeverb2:
Room size, Damping, Predelay, Lowpass,
Highpass, Wet level, and Dry level.

Let's start with the wet and dry levels.
Freeverb works by taking your audio signal and
modifying it to create the reverberated sound,
i.e. the sound you hear echoing off the walls of
the room. This is called the "wet" part of the
effect.

If you set the dry level to 0 and the wet level
to -infinity, it's like standing right in front of
the singer in a tiny room - all you can hear is
the singer, and no reverb. A good place to
start is to set both the dry level and wet level
to 0 dB. However, you may want to
experiment with lowering the dry level while
you are experimenting with the sound of the
reverb.

The room size parameter is self-explanatory.
The smallest room size setting creates a quick,
bright reverb, while the largest setting creates
a long, drawn-out, and dark reverb. The
damping parameter controls how the sound
bounces off the walls - i.e. if it is mostly
reflected or absorbed.

The predelay controls the delay between the
dry signal (unreverberated) and the wet signal
(reverberated) - usually there is some predelay
because of the time it takes sound waves to
travel from the sound source to the nearest
wall, and to the microphone. Larger predelays
are suitable for creating an effect of a larger
room.

Finally, the lowpass and highpass filters can be
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This is mixed together with the original sound,
which is called the "dry" part of the effect, to
produce the combination of direct
(unreverberated) and indirect (reverberated)
sound, which is what you would naturally hear.
If you set the dry level to -infinity and the wet
level to 0 dB, the result is something like
standing outside of a concert hall: you can only
hear the reverberated sound.

Finally, the lowpass and highpass filters can be
used to make the reverberated sound lower or
higher. Increasing the lowpass filter filters out
the high frequencies, and similarly increasing
the highpass filter filters out the low
frequencies.

 

Nyquist Plugins

To use a Nyquist effect, put the effect in the directory (folder) called "Plug-Ins", which should
be in the same directory where Audacity resides. Upon installation, some nyquist scripts are
included, so you needn't worry about creating this directory. The next time you launch Audacity,
any plug-ins you added will appear in the Effect, Generate or Analyse menus.

LADSPA Plugins

These started out a a plugin format for Linux, but can now be used on Windows and OS X as
well. There are lots of free plugins available, and no enabler is needed. More information can be
found on the web.

Back to the main page Back to the Reference page  
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File Menu
New...

Creates a new empty project window.

Open...

Selecting Open presents you with a dialog
where you can choose a file to open. If the
current project window is empty, the new file
will take over the current window, otherwise a
new project window will be opened.

The file formats recognized by Audacity are
WAV,   AIFF,   NeXT/AU,   IRCAM,   MP3,   Ogg
Vorbis,   MIDI, and the Audacity Project file
format (AUP).

In addition, Audacity can also attempt to open
an audio file in a different format, as long as it
is uncompressed - to do this, use the Import
Raw Data command.

Close

Closes the current project window.

Save Project

Saves the current Audacity project (AUP) file.
Audacity projects are not intended to be read
by other programs, but they are extremely fast
to load and save within Audacity. When you
are finished working on a project and you want
to be able to use it in another program, select
one of the Export commands instead.

Note that most of the audio data for an
Audacity project is not stored in the AUP file,
but in a directory (folder) with the same name
as the project. For example, if you save a
project as chanson.aup, there will be a
directory called chanson_data created to store
the actual audio tracks of the project. For more
information on the project file format, see the
file formats page.

Export Selection As WAV...

This is the same as Export, but it only exports
the part of the project that is selected. This is
very useful if you want to save a small clip
from part of a track as a separate file.

Export As MP3...

Exports the current Audacity project as an MP3
file. Audacity does not encode MP3 files
directly, but instead requires that you
download a separate MP3 encoder. See
Exporting MP3 Files for details.

To export only a single track or part of track,
use Export Selection as MP3.

Export Selection As MP3...

This is the same as Export MP3, but it only
exports the part of the project that is selected.
This is very useful if you want to save a small
clip from part of a track as a separate file. See
Exporting MP3 Files.

Export As OGG...

Exports the current Audacity project as an Ogg
Vorbis file.

To export only a single track or part of track,
use Export Selection as Ogg.

Export Selection As OGG...

This is the same as Export As OGG, but it only
exports the part of the project that is selected.
This is very useful if you want to save a small
clip from part of a track as a separate file.

Export Labels...

If you have any Label Tracks, this command
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Save Project As...

Saves the current Audacity project (AUP) file,
allowing you to give it a different name or
move it to a new location if you have already
saved it in one location.

Audacity projects are not intended to be read
by other programs, but they are extremely fast
to load and save within Audacity. When you
are finished working on a project and you want
to be able to use it in another program, select
one of the Export commands instead.

For more information on the project file
format, see the file formats page.

Export As WAV...

Exports the current Audacity project as a
standard audio file format such as
WAV or AIFF.

You can change the format of exported files in
the Preferences dialog.

If there are multiple tracks in your project,
they will be automatically mixed in the
exported data. For more information about
mixing, see Quick Mix.

To export only a single track or part of a track,
use Export Selection.

will export them as a text file. This feature is
commonly used in Speech Recognition research
to annotate a speech utterance and export the
annotation to be later processed by another
program.

To import these labels into a different project
later, use the Import Labels command.

Export Multiple...

This allows you to do multiple exports from
audacity with one command based either on
multiple tracks in the project or labels in a single
audio track. It's great for splitting up long
recordings into CD tracks

Preferences

Opens a dialog window that lets you configure
Audacity. For more information on the different
preferences, see the section on Audacity
Preferences.

Exit/Quit

Closes all project windows and exits Audacity.
It will ask you if you want to save changes to
your project. It is not necessary for you to
save changes if you just exported your file as
WAV or MP3 and you are finished working with
it. On the other hand, if you are working on a
mix and plan to continue where you left off,
saving an Audacity Project will let you restore
everything as it is later.

Back to the main page Back to the Reference page  
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Generate Menu
Silence

Inserts silence. The length is determined by
the length of your selection and the position by
the left boundary of your selection.

If no selection is made, the default length
inserted at the cursor position is 30 seconds.

For example, to insert a two seconds of silence
at a certain point, place the cursor at your
chosen spot, hold the SHIFT  key down, click
and drag your mouse to the right to mark
roughly two seconds, release the mouse button
and activate the Silence function in the
Generate menu. Silence, the length of your
selection, will be inserted at the left boundary
of your selection.

Tone

Inserts a wave of chosen type, frequency and
amplitude. The length is determined by the
length of your selection and the position by the
left boundary of your selection.

If no selection is made, the default length
inserted at the cursor position is 30 seconds.

Parameters:

Waveform Sine, Square, Sawtooth

Frequency(Hz) 1-20000 (value below 1.0 and
above 20000 will be corrected to
1.0 and 20000!)

Amplitude 0-1 - This is the volume of the
generated wave.

White Noise

Inserts white noise. The length is determined
by the length of your selection and the position
by the left boundary of your selection.

If no selection is made, the default length
inserted at the cursor position is 30 seconds.

Pluck

Inserts a synthesized pluck tone. The length is
determined by the length of your selection and
the position by the left boundary of your
selection.

If no selection is made, the default length
inserted at the cursor position is one second.

Pitch 0-127 
The number corresponds to the value of a
midi note, which is assigned to a pitch. The
higher the number, the higher the note.

Back to the main page Back to the Reference page  
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Project Menu
Import Audio...

This command is used to import audio from a
standard audio format into your project. Use
this command if you already have a couple of
tracks, and you want to add another track to
the same project, maybe to mix them
together.

Use this command to import anything except
MIDI files. You cannot yet use this option to
import Audacity Projects.

Import Labels...

This command takes a text file which contains
time codes and labels, and turns them into a
Label Track.

Import MIDI...

This menu command imports MIDI files and
puts them into a Note Track. Audacity can
display MIDI files, but cannot play, edit, or
save them yet.

Import Raw Data...

This menu command allows you to open a file
in virtually any format, as long as it is not
compressed. When you select the file, Audacity
will look through it and try to guess its format.
It will guess correctly about 90% of the time,
so you can try just pressing "OK" and listening
to it. If it is not correct, however, you can use
the dialog presented to try all of the different
possibilities.

At the beginning of your imported track(s), you
may notice a little bit of noise. This is probably
the file's header, which Audacity was not able
to parse. Just zoom in and select the noise
with the Selection Tool, and then choose
Delete.

Quick Mix

This command mixes all of the selected tracks
down to one or two tracks. The channel of a
track being mixed affects whether it will be
mixed into the left channel of the resulting
track(s), the right channel, or both (mono).

For example, if you have four tracks:

Track 1: left channel
Track 2: left channel
Track 3: right channel
Track 4: mono channel

and you select them all and perform a Quick
Mix, you will end up with two tracks: the first
will contain a mix of tracks 1, 2, and 4 (the
new left channel) and the other will contain a
mix of tracks 3 and 4 (the new right channel).

Your tracks are implicitly mixed whenever you
hit the Play button and whenever you select
Export.

Note that if you try to mix two very loud tracks
together, you may get clipping (it will sound
like pops, clicks, and noise). To avoid this, you
should use the track gain controls to reduce
the amplitude of all of your tracks.

New Audio Track

This creates a new empty audio track. This
command is rarely needed, since importing,
recording, and mixing automatically create new
tracks as needed. But you can use this to cut
or copy data from an existing track and paste
it into a blank track.

New Stereo Track

Creates a stereo version of the new audio track
above. You may need this if you start with a
load of mono tracks and want to export a
stereo mix.
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Edit ID3 Tags...

Opens a dialog allowing you to edit the ID3
tags associated with a project, for MP3
exporting.

ID3 Tags are used to store the Title, Artist,
Author, and other information in MP3 files.
When you import an MP3 file, Audacity
remembers this information and stores it with
your project. When you export an MP3 file,
Audacity will prompt you for the ID3 tags,
showing you any tags it collected from an
original MP3 file, or that you typed by selecting
"Edit ID3 Tags" from the Project menu.

Audacity allows you to store ID3 tags in either
the ID3v1 or the ID3v2 format. In general, you
should use the ID3v2 format, because ID3v2
tags go at the beginning of an MP3 file,
whereas ID3v1 tags go at the end. Having the
title and author first means that someone
downloading an MP3 you created will know
that information before they've finished
downloading the song.

New Label Track

This creates a new Label track, which can be
very useful for textual annotation. See the
discussion on Label tracks for more information
on how to use label tracks.

New Time Track

Creates a special track that can be used to
speed up and slow down playback over the
course of the project. This affects all tracks in
the project.

Remove Track(s)

This command removes the selected track or
tracks from the project. Even if only part of a
track is selected, the entire track is removed.
You can also delete a track by clicking the X in
its upper-left corner. To cut out only part of
the audio in a track, use Delete or Silence.

 

Align functions

All the align functions work on whole tracks or groups of tracks, NOT on selections, even if
they span across multiple tracks. Please read the tutorial on how to use the align functions.
You will also find some creative uses and solutions to common problems there. 
These functions operate on each track individually. If more than one track is selected, these
functions do not preserve their position to one another.

Align with Zero

Aligns the start of any selected tracks to the
start of the project.

Align with Cursor

Aligns the start of any selected tracks to the
cursor position.

Align with Selection Start

Aligns the start of any selected tracks to the
start of the current selection

Align with Selection End

Align End with Cursor

Aligns the end of any selected tracks to the
cursor position.

Align End with Selection Start

Aligns the end of any selected tracks to the
start of the current selection

Align End with Selection End

Aligns the end of any selected tracks to the
end of the current selection

Align Tracks Together
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Aligns the start of any selected tracks to the
end of the current selection

If you select multiple tracks, this command
adjusts their time offset so that they start at
the same time. It adjusts their starting time to
the average of all of the tracks' original
starting times. To adjust the time offset of one
track, use the Time Shift tool.

 

Align and Move Cursor

These commands work just like the align commands with the move cursor command
immediately following it.

 

Add Label at Selection

This menu item lets you create a new label at
the current selection. You can title the label by
typing with the keyboard and then hitting
"Enter" when you're done. The label saves your
current selection - so when you click on the
label later it will return the selection to the
state it was in when you created the label. See
the discussion on Label Tracks for more
information on how to use label tracks.

Add Label at Selection

Like Add Label at Selection but the label is
added at the current position during playback.

 
Back to the main page Back to the Reference page  
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View Menu
Zoom In

Zooms in on the horizontal axis of the audio,
displaying more detail about less time. You can
also use the zoom tool to zoom in on a
particular part of the window.

Zoom Normal

Zooms to the default view, which displays
about one inch per second.

Zoom Out

Zooms out, displaying less detail about more
time.

Fit in Window

Zooms out until the entire project just fits in
the window.

Fit Vertically

Adjusts the height of all the tracks until they fit
in the project window.

Zoom to Selection

Zooms in until the selected audio fills the width
of the screen to show the selection in more
detail.

Set Selection Format

Sets the format in which selections are
measured in at the bottom of the application
window. Combined with setting Set Snap-To
Mode to ON, this is ideal to cut stuff up in to
exact measures.

Set Snap-To Mode

History

Brings up the history window. It shows all the
actions you have performed during the current
session, including importing. The right-hand
column shows the amount of HD space your
operations used. You can jump back and forth
between editing steps quite easily by simply
clicking on the entries in the window.

The history window can be kept open at all
times. It doesn't interfere with any other
operations.

Plot Spectrum

To use this feature, first select a region of
audio from a single track, then select "Plot
Spectrum".

It opens up a window which displays the Power
Spectrum of the audio over that region,
calculated using the Fast Fourier Transform.
The graph represents how much energy is in
each frequency.

This window can also display other common
functions that are calculated using the Fast
Fourier Transform, including three versions of
the Autocorrelation function.

The Enhanced Autocorrelation function is very
good at identifying the pitch of a note.

Float or Dock Control Toolbar

Toggles between displaying the tool docked at
the top of each project window, or in a
separate floating window. You can also float
any toolbar by grabbing the handle on the left
side and dragging it to the location you want.

Once they are floating these options change to
docking the toolbars back into the main
window.
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Float or Dock Menu Toolbar

Float or Dock Mixer Toolbar

Float or Dock Meter Toolbar

Do the same thing for the other toolbars

Back to the main page Back to the Reference page  
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Keyboard Shortcuts

!!Apple MacOS X users!! CTRL  = Command

File Commands

New Project CTRL+N

Open Project CTRL+O

Close Project CTRL+W

Save Project CTRL+S

Preferences CTRL+P

Editing Tools

Selection Tool F1

Envelope Tool F2

Editing Tool F3

Zoom Tool F4

Timeshift Tool F5

Multi Tool F6

cycle tool forward D

Navigation, Playback & Recording

Play/Stop SPACE

Loop SHIFT+SPACE

L

Pause P

Record R

Preview 1 second 1

Play From Cursor To
Selection B

  

  

Zoom In CTRL+1

Zoom Normal CTRL+2

Zoom Out CTRL+3

Fit In Window CTRL+F

Fit Vertically CTRL+SHIFT+F
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cycle tool backward A

Edit Commands

Undo CTRL+Z

Redo (Windows) CTRL+Y

Redo (Mac/Unix) CTRL+SHIFT+Z

Cut CTRL+X

Copy CTRL+C

Paste CTRL+V

Delete CTRL+K

DELETE

Silence CTRL+L

Duplicate CTRL+D

Select All CTRL+A

  

Find Zero Crossings Z

Zoom to Selection CTRL+E

  

Import Audio CTRL+I

Create Label CTRL+B

  

Repeat Last Effect CTRL+R

Back to the main page Back to the Reference page  
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